GETTING STARTED GUIDE
NI Digital Waveform Generator/Analyzer

This document explains how to install, configure, and test a National Instruments digital waveform generator/analyzer and how to program it using NI-HSDIO (High-Speed Digital I/O) instrument driver software. This document applies specifically to the following devices:

• NI PXI/PCI-6541/6542
• NI PXIe-6544/6545/6547/6548
• NI PXI/PCI-6551/6552
• NI PXIe-6555/6556
• NI PXI/PCI-6561/6562

For more information about features and programming, refer to the *NI Digital Waveform Generator/Analyzer Help* at Start>all Programs>National Instruments>NI-HSDIO>Documentation>NI Digital Waveform Generator-Analyzer Help.

**Note**  If you are running Windows 8, you may not have a Start menu. To access National Instruments programs and documentation, open the Start screen, type the name of the file or folder you want to access, and select the appropriate icon from the search results.

For example, to access the *NI Digital Waveform Generator/Analyzer Help*, open the Start screen, type *NI Digital Waveform Generator/Analyzer Help*, and select the appropriate icon from the results. To access device specifications, open the Start screen, type your device number (for example, 6556), and select the specifications document for your device. Use this method any time the Start menu is referenced in this document.

Refer to the specifications document that ships with your device for detailed specifications.

The most recent versions of product documentation are available at ni.com/manuals. Visit ni.com/updates for the latest version of NI-HSDIO driver software.
Contents

1. Verifying the System Components ................................................................. 4
2. Unpacking ..................................................................................................... 4
3. Verifying the Kit Contents .......................................................................... 4
   Documentation .............................................................................................. 5
   Ferrites (NI PXIe-6544/6545/6547/6548 Only) ......................................... 5
   EMI Gasket (NI PXI-6551/6552 Only) ....................................................... 5
4. Installing the Software .................................................................................. 5
   Choose and Install Your ADE ..................................................................... 5
   Install NI-HSDIO ....................................................................................... 6
   (Optional) Install the NI Digital Waveform Editor .................................. 6
5. Installing the Hardware .................................................................................. 6
   Installing a PXI Module ............................................................................ 7
   Installing a PXI Express Module ............................................................ 8
   Installing a Two-Slot PXI Express Module ............................................. 9
   Maintaining PXI/PXI Express Systems .................................................. 9
   Uninstalling PXI/PXI Express Modules ................................................ 9
   Installing a PCI Device ......................................................................... 10
   Maintaining PCI Systems ........................................................................ 11
6. Configuring and Testing in MAX ................................................................. 11
   Using the Test Panel to Generate and Acquire Digital Data .................... 12
7. Connecting Signals ....................................................................................... 14
   Connecting Cables ................................................................................... 14
   SMA/SMB Cabling ................................................................................. 14
   NI 654x/655x Cabling ............................................................................ 14
   NI 656x Cabling ....................................................................................... 15
   Using Accessories .................................................................................... 15
   Creating a Custom Accessory ............................................................... 19
   Wiring for Common Measurements ..................................................... 20
   Dynamic Generation ............................................................................... 20
   Dynamic Acquisition ............................................................................. 20
8. Programming the Digital Waveform Generator/Analyzer ......................... 21
   NI-HSDIO Instrument Driver .................................................................. 21
   Acquiring the Data ................................................................................ 21
   NI SignalExpress Limited Edition (LE) .................................................. 21
   NI-HSDIO Examples ............................................................................. 22
Appendix A: Device Front Panels ................................................................. 22
   NI 654x/6551/6552 Front Panels and Connectors .................................. 22
   NI 6555/6556 Front Panels and Connectors .......................................... 27
   NI 656x Front Panels and Connectors ................................................... 30
Appendix B: Troubleshooting ......................................................................... 35
   Device Front Panel ACCESS LED on PXI Module is Off When PXI Chassis is On ............................................................................ 35
   Device Does Not Appear in MAX .......................................................... 35
   Device Failed the Self-Test .................................................................... 35
   I Received a Thermal or Power Shutdown Error .................................... 36
Performance Issues Using MXI Connection .............................................................. 36
Where to Go for Support ....................................................................................... 37
1. Verifying the System Components

Your system must meet certain requirements to use NI digital waveform generator/analyzers with NI-HSDIO. For more information about minimum system, recommended system, and supported application development environments (ADEs), refer to the *NI-HSDIO Instrument Driver Readme*, which is available on the NI-HSDIO DVD.

**Note** After you install NI-HSDIO, you can access the *NI-HSDIO Instrument Driver Readme* at `Start»All Programs»National Instruments»NI-HSDIO»Documentation`.

2. Unpacking

The NI digital waveform generator/analyzer ships in an antistatic package to prevent electrostatic discharge (ESD). ESD can damage several components on the device.

**Caution** Never touch the exposed pins or connectors.

To avoid ESD damage when handling the device, take the following precautions:
- Ground yourself with a grounding strap or by touching a grounded object.
- Touch the antistatic package to a metal part of your computer chassis before removing the device from the package.

Remove the device from the package and inspect it for loose components or any other signs of damage. Notify NI if the device appears damaged in any way. Do not install a damaged device in your computer or chassis.

Store the device in the antistatic package when the device is not in use.

3. Verifying the Kit Contents

Verify that the kit contains the following items:

- NI-HSDIO instrument driver software DVD. This DVD installs the NI-HSDIO driver, which includes the *NI Digital Waveform Generator/Analyzer Help* and other documentation. Refer to the *Documentation* section for a list of possible additional documentation.

- *NI Digital Waveform Generator/Analyzer Getting Started Guide*

- NI digital waveform generator/analyzer device

- Mounting screw (PCI devices only)
Documentation

The NI digital waveform generator/analyzer kit may also include the following documents:

- NI digital waveform generator/analyzer specifications—This printed document provides specifications for your device.
- Read Me First: Safety and Electromagnetic Compatibility
- Maintain Forced-Air Cooling Note to Users
- Retrofitting Your PXI Module Note to Users (NI PXI-6551/6552 only)
- Using Ferrites to Reduce High-Frequency Emissions Note to Users (applicable devices only)

Ferrites (NI PXIe-6544/6545/6547/6548 Only)

The NI PXIe-6544/6545/6547/6548 kit also includes two ferrites and documentation that describes under what conditions you should install the ferrites. Refer to the Using Ferrites to Reduce High-Frequency Emissions Note to Users for more information about using the ferrites.

EMI Gasket (NI PXI-6551/6552 Only)

The NI PXI-6551/6552 kit also includes an EMI gasket and documentation that describes under what conditions you should install the gasket. Refer to step 5. Installing the Hardware for more information about the gasket.

4. Installing the Software

This section describes the software installation process for the NI digital waveform generator/analyzer.

Choose and Install Your ADE

You can create applications for your digital waveform generator/analyzer using LabVIEW, LabWindows™/CVI™, or Microsoft Visual C++.

LabVIEW features interactive graphics, a state-of-the-art interface, and a powerful graphical programming language. LabWindows/CVI is a complete ANSI C ADE that features an interactive user interface, code generation tools, and the LabWindows/CVI Data Acquisition libraries. Using LabVIEW or LabWindows/CVI can greatly reduce your application development time.

If you have not already installed the ADE, follow the instructions in the product documentation to install your ADE now.
Install NI-HSDIO

NI-HSDIO features a set of operations and attributes that allow you to programatically configure and control the digital waveform generator/analyzer.

To install NI-HSDIO, complete the following steps:

1. Insert the NI-HSDIO DVD. The NI-HSDIO installer should open automatically. If not, select **Start»Run**, and enter `x:\setup.exe`, where `x` is the letter of the DVD drive.
2. Follow the instructions in the installation prompts. For troubleshooting and operating system-specific instructions, refer to the Hardware Installation/Configuration Troubleshooter at ni.com/support.
   *(Windows 7/Vista)* Users may see access and security messages during installation. Accept the prompts to complete the installation.
3. When the installer finishes, a dialog box appears that asks if you want to restart, shut down, or restart later. Select **Restart**.
4. If you are using a system running the LabVIEW Real-Time Module, download NI-HSDIO to the target using MAX. Refer to the **MAX Remote Systems Help** by selecting **Help»Help Topics»Remote Systems in MAX**.

**NI Script Editor**
The NI Script Editor is included on the NI-HSDIO DVD and is installed when you install the driver. The NI Script Editor provides an intuitive interface to help you develop linking and looping waveform generation operations. **NI Script Editor Help** contains more information about the NI Script Editor. You can access **NI Script Editor Help** by launching the NI Script Editor and selecting **Help»NI Script Editor Help** from the toolbar.

*Note* Visit ni.com/updates for the latest version of NI-HSDIO driver software.

(Optional) Install the NI Digital Waveform Editor

The NI Digital Waveform Editor (DWE) is included with the higher-memory versions of NI digital waveform generator/analyzers and also can be purchased separately at ni.com. The NI DWE allows you to easily import data from popular third-party electronic design automation (EDA) programs, create your own waveforms, edit these waveforms, and view acquired waveforms.

If you are using the NI DWE, install it after you install NI-HSDIO.

5. Installing the Hardware

To install your NI digital waveform generator/analyzer, follow the instructions in the section that describes your hardware platform.

When installing your hardware, follow the instructions in this section to ensure that your device can cool itself effectively. If the device temperature rises above the optimal operating temperature range, the device disables itself, and MAX or NI-HSDIO notifies you with an error.
message. For more information about re-enabling your device, refer to the I Received a Thermal or Power Shutdown Error section in Appendix B: Troubleshooting.

Installing a PXI Module

To install a PXI module, refer to Figure 1 and complete the following steps:

1. Power off the chassis before installing the module.
2. If the chassis has multiple fan speed settings, ensure that the fans are set to the highest setting. Do not set the fan speed to low or turn the fan off.
3. Position the chassis to allow plenty of space between the chassis fan intake and exhaust vents. Blocking the fans affects the air flow needed for cooling. For more information about chassis cooling, refer to the chassis documentation.
4. If you need to use an EMI gasket to reduce high-frequency emissions, install it now. Refer to the Retrofitting Your PXI Module Note to Users for gasket installation instructions.
5. Remove the packaging material on the PXI connector and on the screws.
6. Ensure that the ejector handle is in the unlatched (downward) position, as shown in Figure 1.
7. Holding the module by the ejector handle, slide it into an empty slot, ensuring that the base card (on the left when looking at the front of the module) engages with the card guides in the chassis.
8. Slide the module completely into the chassis and latch by pulling up on the ejector handle.
9. Tighten the captive screws at the top and bottom of the module front panel.
10. Before operating the module, install all chassis covers and filler panels. Missing filler panels disrupt the necessary air circulation in the chassis.
11. Plug in and power on the chassis.

NI PXI modules are sensitive instruments that should be handled carefully. Do not expose the module to temperatures or humidity beyond the rated maximums. Keep the module free of dust by cleaning with compressed air only. Do not clean the module with any solvents or liquids. For more information about module cooling, refer to the guidelines in the *Maintain Forced-Air Cooling Note to Users* included with your NI digital waveform generator/analyzer.

**Installing a PXI Express Module**

Follow the installation instructions in the *Installing a PXI Module* section to install a PXI Express module in a PXI Express-compatible slot of the chassis. Refer to the chassis documentation for more information about which slots are designated for PXI Express modules. Figure 2 shows the correct installation of a PXI Express module into a compatible chassis slot.

**Figure 2. PXI Express Module Installation**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PXI Express Chassis</td>
</tr>
<tr>
<td>2</td>
<td>Ejector Handle in Down Position</td>
</tr>
<tr>
<td>3</td>
<td>NI PXI Express Module</td>
</tr>
<tr>
<td>4</td>
<td>Captive Screw</td>
</tr>
</tbody>
</table>
Installing a Two-Slot PXI Express Module

Follow the installation instructions in the Installing a PXI Express Module section to install a two-slot PXI Express module in a PXI Express-compatible slot of the chassis. For dual-slot modules with two backplane connectors, like the NI 6555/6556, the module must be installed into two adjacent PXI Express-compatible slots. These slots may be hybrid PXI Express slots. Refer to the chassis documentation for more information about which slots are designated for PXI Express modules. Figure 3 shows the correct installation of a PXI Express module into a compatible chassis slot.

Figure 3. Two-Slot PXI Express Module Installation

Maintaining PXI/PXI Express Systems

Some chassis include fan filters. Clean the fan filters on the chassis regularly to prevent fan blockage and ensure efficient air circulation. Cleaning frequency depends on the amount of use and the operating environment. For specific information about cleaning procedures and other recommended maintenance, refer to the module specifications and the chassis user documentation.

Uninstalling PXI/PXI Express Modules

When removing PXI/PXI Express modules from the chassis, first power off the chassis. Then, ensure that you are grounded with a grounding strap or are touching a grounded metal surface. To avoid ESD, do not touch the exposed pins of the PXI/PXI Express connector or any exposed circuitry on the module. When not in use, PXI/PXI Express modules should be stored in the original antistatic packaging to avoid damage.
Hot Surface  During operation, the metal surfaces of PXI/PXI Express modules may become hot. Be careful when removing the module from the chassis or when moving it to a different peripheral slot. When removing the module, hold it by only the ejector handle and front panel.

Installing a PCI Device
To install your PCI device, complete the following steps:
1. Power off and unplug the PC.
2. Remove the PC cover.
3. If the PC has multiple fan speed settings, ensure that the fans are set to the highest setting.
4. Insert the device into an open PCI slot, as shown in Figure 4.

\begin{figure}[h]
\centering
\includegraphics[width=0.5\textwidth]{PCI_Installation.png}
\caption{PCI Installation}
\end{figure}

NI recommends either leaving the slot adjacent to the fan side of the device empty or using lower-profile devices in the slot adjacent to the fan side.

5. Secure the device with the screw provided in the kit.

\begin{table}[h]
\centering
\begin{tabular}{ccc}
1 & NI PCI Device & 2 & PCI Slot & 3 & Personal Computer \\
\hline
& NI PCI Device & & PCI Slot & & Personal Computer \\
\end{tabular}
\end{table}

Caution  It is important to completely screw the device into the PCI slot, both for mechanical stability and for creating a solid ground connection, which reduces signal noise. Some computer manufacturers use a plastic securing lever to secure PCI devices; such a lever is unacceptable and must be removed, or you must use a different chassis. Improperly secured devices may affect the accuracy of device specifications.
6. Before operating the device, install all filler panels. Missing filler panels disrupt the necessary air circulation in the PC.

7. Replace the PC cover.

8. Plug in and power on the PC.

**Maintaining PCI Systems**

Inspect the onboard fan on a regular basis to prevent fan blockage and ensure efficient air circulation. Cleaning frequency depends on the amount of use and the operating environment.

### 6. Configuring and Testing in MAX

To configure and test the NI digital waveform generator/analyzer in MAX, complete the following steps:

1. Launch MAX to configure and test the digital waveform generator/analyzer. MAX should automatically detect the device you installed.

2. Expand **Devices and Interfaces**.
   
   If you are using an NI digital waveform generator/analyzer with the LabVIEW Real-Time Module, expand **Remote Systems**. Find your target IP address or name, expand it, and then expand **Devices and Interfaces**.

3. Check that your device appears under **Devices and Interfaces**.

   **Note** If your device does not appear under **Devices and Interfaces**, MAX did not detect the device, so you might need to refresh MAX by selecting **File»Refresh** from the MAX menu or pressing <F5>.

4. You can perform a self-test on devices listed under **Devices and Interfaces**. The self-test ensures that the device is installed correctly and can communicate with NI-HSDIO. To perform a self-test, complete the following steps:
   a. Right-click the device you want to test.
   b. Select **Self-Test**, shown in Figure 5.
c. When the self-test finishes, a dialog box indicates if an error occurred. If an error occurred, refer to ni.com/support for troubleshooting information.

**Tip**  
If you need to reset the device with a hard reset, you can do so by right-clicking the device and selecting **Reset Device** from the shortcut menu shown in Figure 5.

5. Record the device name assigned to the digital device. You need this information when you program the device.

**Using the Test Panel to Generate and Acquire Digital Data**

To verify your device configuration, use the device test panel in MAX to generate and acquire simple digital data using your device by completing the following steps:

1. Remove any signal connections to your device.
2. Right-click the device under the appropriate Chassis, and select **Test Panels** as shown in Figure 5.
3. Click the **Generation** tab.
4. Select the **Dynamic** tab on the side of the pane.
5. Click **Select All** to select all of your channels. The digital waveform now appears in the graph.
6. Enter the frequency in the **Clock Frequency** control, located on the left side of the test panel.
7. Enter values for the generation and acquisition voltages in the controls below the **Clock Frequency** control. You can choose from standard logic families (NI 654x/655x) or enter High and Low values to create your own custom levels (NI 655x).
8. Choose a fill pattern. The following figure shows the pattern control and the first few signals in the window.

![Pattern Control](image)

**Tip** When generating a Marching Ones or Marching Zeroes waveform, it is convenient to make the waveform size a multiple of the number of selected channels.

9. Click **Play** to generate the waveform shown in the graph on the selected channels. The default generation option is Continuous, but you can toggle this setting using the control below the graph.

The Play and Stop buttons are shown in the following figure.

![Play and Stop Buttons](image)

Because the data channels on the NI digital waveform generator/analyzer are bidirectional, while the data is being continuously generated on all of the channels, as in the previous step, you can acquire the data being generated.

**Note** Refer to the specifications for your device for information about the setup and hold times and propagation delays associated with generation and acquisition operations. At some frequencies, generating and acquiring data on the same channels when no cable is attached to the DIGITAL DATA & CONTROL (DDC) connector violates these timing parameters and results in incorrectly sampled data. For information about proper signal acquisition, refer to the *NI Digital Waveform Generator/Analyzer Help*.

To acquire the waveform, complete the following steps:

1. Click the **Acquisition** tab.
2. Click **Play**. The device acquires the digital data that you generated in the previous steps, and the data is displayed on the graph.
3. Click **Close** when you are finished.
7. Connecting Signals

This section discusses connections you can make to the device and how to connect signals to the device for performing dynamic acquisition and dynamic generation. For device front panel diagrams and connector descriptions, refer to *Appendix A: Device Front Panels.*

**Connecting Cables**

**SMA/SMB Cabling**

To make connections to the NI digital waveform generator/analyzer front panel SMA/SMB jack connectors, use a shielded 50 Ω coaxial cable with an appropriate plug end.

**NI 654x/655x Cabling**

Use an NI SHC68-C68-D4 cable for connections to the NI 654x/655x Digital Data and Control (DDC) connector and the REMOTE SENSE connector (NI 6555/6556 only). The NI SHC68-C68-D4 is designed for single-ended, high-speed digital signal transmission. The cable is shielded, with individual microcoaxial 50 Ω lines for each signal. An unshielded NI C68-C68-D4 cable may also be used.

NI 6555/6556 Cabling

If leakage is a concern for your application, use the NI SHC68-C68-D4 low-leakage cable (NI part number 152870A-01) when connecting to the DDC and REMOTE SENSE connectors on the NI 6555/6556.

For ease of use and safety, always operate connections to the AUX I/O connector on the NI 6556 with the backshell provided in the shipping kit. Additional backshell kits can be purchased from NI (part number 762916-01). Operating the device without the provided backshell can expose users to high voltage. The following image illustrates the NI 6556 and backshell connector. Refer to the *NI PXIe-6555/6556 Specifications* for the working voltage levels of the AUX I/O connector.
NI 656x Cabling

Use an SHB12X-B12X cable for connections to the NI 656x DDC connector. This cable is designed for differential, high-speed digital signal transmission.

Using Accessories

You have different accessory options based on whether you are using a single-ended or differential NI digital waveform generator/analyzer.

**Note** Whether you use NI cables and accessories or design your own, you should properly terminate cables to avoid improper measurements due to signal reflections, overshoot, and undershoot. Refer to the *NI Digital Waveform Generator/Analyzer Help* for more information about signal termination.

Single-Ended Accessories

NI recommends using the NI CB-2162 single-ended digital I/O accessory to access the signals on the 68-pin DDC connector and to terminate the DIO channels. The NI CB-2162 also provides a platform for circuit prototyping and DUT testing. The NI CB-2162 is specifically designed for use with single-ended NI digital waveform generator/analyzers (NI 654x/655x). For more information about the NI CB-2162, refer to the *NI CB-2162 User Guide*. 
NI also offers the NI SMB-2163 breakout box for National Instruments single-ended digital waveform generator/analyzers. The NI SMB-2163 offers coaxial SMB connectors for each channel on the DDC connector, providing an easy way to connect to other devices for testing and debugging. For more information about the NI SMB-2163, refer to the *NI SMB-2163 User Guide*.

Figures 7 and 8 show how to connect a single-ended NI digital waveform generator/ana\-\zer and the NI CB-2162 and NI SMB-2163, respectively, using the NI SHC68-C68-D4 cable.

**Figure 7. Connecting the NI CB-2162 Accessory**

![Figure 7](image1)

1 PXI Chassis with NI Digital Waveform Generator/Analyzer
2 NI SHC68-C68-D4 Cable
3 NI CB-2162 Accessory

**Figure 8. Connecting the NI SMB-2163 Accessory**

![Figure 8](image2)

1 PXI Chassis with NI Digital Waveform Generator/Analyzer
2 NI SMB-2163 Accessory
3 NI SHC68-C68-D4 Cable
The NI SHC68-H1X38 cable is a single-ended cable that breaks out each single-ended NI digital waveform generator/ analyzer signal into two 0.1 inch header receptacles, one receptacle each for the signal and ground. The NI SHC68-H1X38 cable provides an easy way to connect NI single-ended high-speed digital waveform generator/analyzer devices to various types of devices and circuits for interfacing, testing, or analysis.

This cable offers connectivity similar to that found on a typical logic analyzer, so you can use it in logic analyzer-type applications. Unlike a typical logic analyzer, however, this cable also allows for simultaneous pattern generation and acquisition so that you can use it in stimulus/response applications as well. The following figure shows the parts locator diagram for the single-ended digital flying lead cable.

**Figure 9. Single-Ended Flying Lead Cable Parts Locator Diagram**
Differential Accessories

The NI SMA-2164 test fixture is a breakout box for National Instruments differential digital waveform generator/analyzer modules (NI 656x). This fixture provides an easy way to connect to other devices for testing and debugging. For more information about using the NI SMA-2164, refer to the *NI SMA-2164 User Guide*.

Figure 10 shows how to connect a differential NI digital waveform generator/analyzer to the NI SMA-2164, using the NI SHB12X-B12X cable.

**Figure 10. Connecting the NI SMA-2164 Accessory**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NI Digital Waveform Generator/Analyzer, installed in a PXI chassis</td>
</tr>
<tr>
<td>2</td>
<td>NI SHB12-B12X Cable</td>
</tr>
<tr>
<td>3</td>
<td>NI SMA-2164</td>
</tr>
</tbody>
</table>
A flying lead cable, the NI SHB12X-H3X24, is also available for differential NI digital waveform generator/analyzers (NI 656x). This cable offers connectivity similar to that found on a typical logic analyzer, so you can use it in logic analyzer-type applications. The cable is shown in Figure 11.

Figure 11. NI SHB12X-H3X24 Flying Lead Cable

Creating a Custom Accessory

Many common NI digital waveform generator/analyzer applications may require you to create a custom accessory to easily access the signals of your device under test (DUT). If you are creating a custom accessory to use with a device with a VHDCI DDC connector, you can purchase the mating connector for the VHDCI cable from NI. If you are designing a custom accessory to use with a device that uses an Infiniband connector, you can also purchase this connector. For more information about creating these custom accessories, refer to the Interfacing to the NI Digital Waveform Generator/Analyzer using the VHDCI Connector application note, available by entering rdnwa in the text field at ni.com/info. Refer to Appendix A: Device Front Panels for signal descriptions and pinout illustrations.

Note Whether you use NI cables and accessories or design your own, you should properly terminate cables to avoid improper measurements due to signal reflections, overshoot, and undershoot. Refer to the NI Digital Waveform Generator/Analyzer Help for more information about signal termination.
If you are designing a custom cabling solution with connector (779157-01) and the NI SHB12X-B12X cable (192344-01), the NI 656x pinout is reversed at the end connector. Refer to Figure 18 for an illustration of the pinout at the end connector.

Wiring for Common Measurements
Dynamic generation and dynamic acquisition are two categories of applications that you can create for NI digital waveform generator/analyzers. This section provides information about the general wiring considerations for each type of application. Both examples use the NI 655x and the NI CB-2162 for signal termination.

Dynamic Generation
When performing dynamic generation, an NI digital waveform generator/analyzer (NI 654x/655x) generates data through a matched impedance system that consists of a 50 Ω output impedance, a 50 Ω cable, and a 50 Ω accessory. Figure 12 shows a diagram of such a system, using the NI 655x as an example. Depending on the loading of the peripheral device, you may need additional parallel termination resistance at the destination for optimal signal quality. Refer to the NI Digital Waveform Generator/Analyzer Help for more information about signal termination.

Figure 12. Dynamic Generation Functional Diagram

![Dynamic Generation Functional Diagram](image1)

Dynamic Acquisition
When performing dynamic acquisition with the NI 654x/655x, the source generating the signals needs a matched source impedance as close to 50 Ω as possible to minimize signal reflections and maintain optimal signal quality. Figure 13 shows a diagram of a dynamic acquisition system using the NI 655x as an example.

Figure 13. Dynamic Acquisition Functional Diagram

![Dynamic Acquisition Functional Diagram](image2)
Note  NI digital waveform generator/analyzers have various input impedances (R<sub>i</sub>). Refer to the specifications document for your device for supported input impedance settings.

Refer to the *NI Digital Waveform Generator/Analyzer Help* for more information about signal termination.

8. Programming the Digital Waveform Generator/Analyzer

You can generate or acquire digital data with the NI digital waveform generator/analyzer using NI-HSDIO or NI SignalExpress. You also can run the NI-HSDIO examples to demonstrate the functionality of your device.

**NI-HSDIO Instrument Driver**

The NI-HSDIO API features a set of operations and attributes that exercise all the functionality of the device, including configuration, control, and other device-specific functions.

**Acquiring the Data**

For detailed instructions about how to acquire data in a specific ADE, refer to the *Getting Started* section of the *NI Digital Waveform Generator/Analyzer Help* located at **Start»All Programs»National Instruments»NI-HSDIO»Documentation»NI Digital Waveform Generator/Analyzer Help»Programming»Getting Started with NI-HSDIO**.

**Tip**  You can modify an NI-HSDIO C example to create an application with Microsoft Visual C/C++, and all required include and library files are automatically added to the project. Refer to the *Using NI-HSDIO Visual C++* topic of the *NI Digital Waveform Generator/Analyzer Help* if you prefer to manually add all required include and library files to the project.

**NI SignalExpress Limited Edition (LE)**

NI-HSDIO 1.5 and later includes a stand-alone, evaluation version of NI SignalExpress that allows you to quickly configure your NI hardware to acquire, generate, or perform hardware comparison using your NI digital waveform generator/analyzer. This software integrates with the NI Digital Waveform Editor to allow you to create and modify complex digital waveforms and then generate the data on your NI digital waveform generator/analyzer.

NI SignalExpress LE (limited edition) gives you a 30-day trial of the Full Edition of NI SignalExpress. After that period, you must activate your version of NI SignalExpress LE, which is free, or purchase the Full Edition. NI SignalExpress LE includes the NI-HSDIO express steps, and the Full Edition includes analysis, signal processing, and other advanced features. If you activate your version of NI SignalExpress LE before your 30-day trial of the Full Edition is complete, the full features are still available for the remainder of your 30-day trial.
Note  The NI 6555/6556 is not supported in NI SignalExpress.

Note  Real-time hardware comparison in NI SignalExpress is supported only on
NI 6547/6548/6551/6552 devices.

NI-HSDIO Examples

Examples demonstrate the functionality of the device, serving as programming models and
building blocks for your own applications. The NI Example Finder is a utility available for some
software applications that organizes examples into categories and allows you to easily browse
and search installed examples. You can see descriptions and compatible hardware models for
each example or see all the examples compatible with one particular hardware model.

To locate examples, refer to the following table.

<table>
<thead>
<tr>
<th>Software Application</th>
<th>Locating Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>LabVIEW or LabWindows/CVI</td>
<td>Locate examples with the NI Example Finder. Within LabVIEW or LabWindows/CVI, select Help&gt;Find Examples and navigate to Hardware Input and Output&gt;Modular Instruments&gt;NI-HSDIO.</td>
</tr>
<tr>
<td>ANSI C or Visual Basic</td>
<td>Locate examples in the &lt;NIDocDir&gt;\NI-HSDIO\examples directory, where &lt;NIDocDir&gt; is the following directory: (Windows Vista/Windows 7/Windows 8) Users\Public\Documents\National Instruments</td>
</tr>
</tbody>
</table>

Appendix A: Device Front Panels

This section contains front panel connector figures and connector description tables that describe
the signal connection options for NI digital waveform generator/analyzers.

NI 654x/6551/6552 Front Panels and Connectors

The NI 654x/6551/6552 front panels contain four connectors—three SMB jacks (NI 6541/6542/6551/6552) or SMA connectors (NI 6544/6545/6547/6548) named CLK IN, PFI 0, and CLK OUT, and one 68-pin VHDCI connector named DIGITAL DATA & CONTROL, or DDC.
Figure 14 shows the NI 6541 front panel and DDC pinout, which is identical to the DDC pinout of the NI 6542/6544/6545/6547/6548, though the NI 6544/6545/6547/6548 uses SMA instead of SMB connectors. The DDC signals are described in Table 1. The SMB connectors are described in Table 7. The LEDs are described in Tables 8 and 9.

Figure 14. NI 654x Front Panel Connectors
<table>
<thead>
<tr>
<th>Pins</th>
<th>Signal Name</th>
<th>Signal Type</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>DDC CLK OUT</td>
<td>Control</td>
<td>Output terminal for the exported Sample clock.</td>
</tr>
<tr>
<td>67</td>
<td>STROBE</td>
<td>Control</td>
<td>Terminal for the external Sample clock source, which can be used for dynamic acquisition.</td>
</tr>
<tr>
<td>1, 3, 5, 7, 9, 11, 13, 15, 17, 19, 21, 23, 25, 27, 29, 31, 35, 37, 39, 41, 43, 45, 47, 49, 51, 53, 55, 57, 59, 61, 63, 65</td>
<td>DIO &lt;0..31&gt;</td>
<td>Data</td>
<td>Bidirectional digital I/O data channels 0 through 31.</td>
</tr>
<tr>
<td>26, 30, 64</td>
<td>PFI &lt;1..3&gt;</td>
<td>Control</td>
<td>Input terminals to the NI 654x for external triggers, or output terminals from the NI 654x for events.</td>
</tr>
<tr>
<td>2, 4, 6, 10, 12, 14, 16, 18, 20, 22, 24, 28, 32, 34, 36, 38, 40, 42, 44, 46, 48, 50, 54, 56, 58, 62, 66</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for signals.</td>
</tr>
<tr>
<td>8, 52, 60</td>
<td>RESERVED</td>
<td>N/A</td>
<td>These terminals are reserved for future use. Do not connect to these pins.</td>
</tr>
</tbody>
</table>
Figure 15 shows the NI 6551 front panels and pinout, which are identical to those of the NI 6552. The DDC signals are described in Table 2. The SMB connectors are described in Table 7. The LEDs are described in Tables 8 and 9.

**Figure 15.** NI 6551/6552 Front Panel Connectors
<table>
<thead>
<tr>
<th>Pins</th>
<th>Signal Name</th>
<th>Signal Type</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>DDC CLK OUT</td>
<td>Control</td>
<td>Output terminal for the exported Sample clock.</td>
</tr>
<tr>
<td>67</td>
<td>STROBE</td>
<td>Control</td>
<td>Terminal for the external Sample clock source, which can be used for dynamic acquisition.</td>
</tr>
<tr>
<td>13, 15, 17, 19, 21, 23, 25, 27, 29, 31, 47, 49, 51, 53, 55, 57, 59, 61, 63, 65</td>
<td>DIO &lt;0..19&gt;</td>
<td>Data</td>
<td>Bidirectional digital I/O data channels 0 through 19.</td>
</tr>
<tr>
<td>26, 30, 64</td>
<td>PFI &lt;1..3&gt;</td>
<td>Control</td>
<td>Input terminals to the NI 6551/6552 for external triggers, or output terminals from the NI 6551/6552 for events.</td>
</tr>
<tr>
<td>2, 4, 6, 10, 12, 14, 16, 18, 20, 22, 24, 28, 32, 34, 36, 38, 40, 42, 44, 46, 48, 50, 54, 56, 58, 62, 66</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for signals.</td>
</tr>
<tr>
<td>1, 3, 5, 7, 8, 9, 11, 35, 37, 39, 41, 43, 45, 52, 60</td>
<td>RESERVED</td>
<td>N/A</td>
<td>These terminals are reserved for future use. Do not connect to these pins.</td>
</tr>
</tbody>
</table>
Remote Sense signals are described in Table 4. The NI 6556 AUX I/O signals are described in Table 5. The SMA connectors are described in Table 7. The LEDs are described in Table 9.

Figure 16 shows the pinouts of the NI 6556 VHDCI connectors, which are identical to the pinouts of the NI 6555 VHDCI connectors. The DDC signals are described in Table 3. The REMOTE SENSE signals are described in Table 4. The NI 6556 AUX I/O signals are described in Table 5. The SMA connectors are described in Table 7. The LEDs are described in Tables 8 and 9.

**Figure 16. NI 6556 Front Panel Connectors**
<table>
<thead>
<tr>
<th>Pins</th>
<th>Signal Name</th>
<th>Signal Type</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9, 11, 13, 15, 17, 19, 21, 23, 25, 27, 29, 31, 43, 45, 47, 49, 51, 53, 55, 57, 59, 61, 63, 65</td>
<td>DIO &lt;0..23&gt;</td>
<td>Data</td>
<td>Bidirectional PPMU-capable digital I/O data channels 0 through 23.</td>
</tr>
<tr>
<td>26, 64</td>
<td>PFI &lt;1..2&gt;</td>
<td>Control</td>
<td>PPMU-capable input terminals to the NI 6555/6556 for external triggers, or output terminals from the NI 6555/6556 for events.</td>
</tr>
<tr>
<td>1, 3, 5, 7, 30, 35, 37, 39, 41</td>
<td>PFI 3, PFI &lt;24..31&gt;</td>
<td>Control</td>
<td>Single-ended input terminals to the NI 6555/6556 for external triggers, or output terminals from the NI 6555/6556 for events. Refer to the NI 6555/6556 Specifications for signal voltage levels.</td>
</tr>
<tr>
<td>33</td>
<td>PFI 4 / DDC CLK OUT</td>
<td>Control</td>
<td>Bidirectional PPMU-capable terminal for an exported Sample clock or for trigger and event routing.</td>
</tr>
<tr>
<td>67</td>
<td>PFI 5 / STROBE</td>
<td>Control</td>
<td>Bidirectional PPMU-capable terminal for external Sample clock source that can be used only for dynamic acquisition or for trigger and event routing.</td>
</tr>
<tr>
<td>2, 4, 6, 8, 10, 12, 14, 16, 18, 20, 22, 24, 28, 32, 34, 36, 38, 40, 42, 44, 46, 48, 50, 52, 54, 56, 58, 62, 66, 68</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for signals.</td>
</tr>
<tr>
<td>60</td>
<td>RESERVED</td>
<td>N/A</td>
<td>These terminals are reserved for future use. Do not connect to these pins.</td>
</tr>
<tr>
<td>Pins</td>
<td>Signal Name</td>
<td>Signal Type</td>
<td>Signal Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>9, 11, 13, 15, 17, 19, 21, 23, 25, 27, 29, 31, 43, 45, 47, 49, 51, 53, 55, 57, 59, 61, 63, 65</td>
<td>DIO &lt;0..23&gt; SENSE</td>
<td>Analog</td>
<td>Remote sense pins for PPMU channels 0 through 23.</td>
</tr>
<tr>
<td>26, 64</td>
<td>PFI &lt;1..2&gt; SENSE</td>
<td>Analog</td>
<td>Remote sense pins for PFI &lt;1..2&gt;.</td>
</tr>
<tr>
<td>33, 67</td>
<td>PFI &lt;4..5&gt; SENSE</td>
<td>Analog</td>
<td>Remote sense pin for PFI &lt;4..5&gt;</td>
</tr>
<tr>
<td>3, 5, 7, 30, 39, 41</td>
<td>NC</td>
<td>No connect</td>
<td>Do not connect to these terminals.</td>
</tr>
<tr>
<td>60</td>
<td>CAL GND</td>
<td>Analog ground</td>
<td>Ground reference for external calibrator.</td>
</tr>
<tr>
<td>2, 4, 6, 8, 10, 12, 14, 16, 18, 20, 22, 24, 28, 32, 34, 36, 38, 40, 42, 44, 46, 48, 50, 52, 54, 56, 58, 62, 66, 68</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for signals.</td>
</tr>
<tr>
<td>1</td>
<td>CAL DMM</td>
<td>Analog</td>
<td>Resource used during external calibration.</td>
</tr>
<tr>
<td>35</td>
<td>EXTERNAL SENSE</td>
<td>Analog</td>
<td>Resource used for external SMU or DC sense functions.</td>
</tr>
<tr>
<td>37</td>
<td>EXTERNAL FORCE</td>
<td>Analog</td>
<td>Resource used for external SMU or DC force functions.</td>
</tr>
</tbody>
</table>
The NI 656x front panels contain four connectors—three SMB jacks (CLK IN, PFI 0, and CLK OUT) and one 73-pin 12x Infiniband connector (DIGITAL DATA & CONTROL, or DDC).

Figure 17 shows the NI 6561 front panels and pinout, which are identical to those of the NI 6562. Signals marked with an asterisk represent the complementary terminal for the differential signal of the same name. The DDC signals are described in Table 6. The SMB connectors are the same as those described in Table 7, and the LEDs are the same as those described in Tables 8 and 9.

---

**Table 5. NI 6556 AUX I/O Connector Pins**

<table>
<thead>
<tr>
<th>Pins</th>
<th>Signal Name</th>
<th>Signal Type</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>External Force</td>
<td>Analog</td>
<td>Resource for external SMU or DC force functions.</td>
</tr>
<tr>
<td>2, 4</td>
<td>Guard</td>
<td>Analog</td>
<td>Guard connection for external SMUs or DC sources.</td>
</tr>
<tr>
<td>3</td>
<td>External Sense</td>
<td>Analog</td>
<td>Resource for external SMU or DC sense functions.</td>
</tr>
<tr>
<td>5</td>
<td>Cal</td>
<td>Analog</td>
<td>Resource used during external calibration.</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for external signals.</td>
</tr>
</tbody>
</table>

---

**NI 656x Front Panels and Connectors**

The NI 656x front panels contain four connectors—three SMB jacks (CLK IN, PFI 0, and CLK OUT) and one 73-pin 12x Infiniband connector (DIGITAL DATA & CONTROL, or DDC).
Figure 17. NI 656x Front Panel Connectors

### Note
If you are designing a custom cabling solution with connector (779157-01) and the NI SHB12X-B12X cable (192344-01), the NI 656x pinout is reversed at the end connector. Refer to Figure 18 for an illustration of the pinout at the end connector.
<table>
<thead>
<tr>
<th>Pins</th>
<th>Signal Name</th>
<th>Signal Type</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>65</td>
<td>DDC CLK OUT LVDS</td>
<td>Control</td>
<td>Positive terminal for the exported Sample clock.</td>
</tr>
<tr>
<td>66</td>
<td>DDC CLK OUT LVDS*</td>
<td>Control</td>
<td>Complementary terminal for the LVDS exported Sample clock.</td>
</tr>
<tr>
<td>71</td>
<td>DDC CLK OUT LVPECL</td>
<td>Control</td>
<td>Positive terminal for the LVPECL exported Sample clock.</td>
</tr>
<tr>
<td>72</td>
<td>DDC CLK OUT LVPECL*</td>
<td>Control</td>
<td>Complementary terminal for the LVPECL exported Sample clock.</td>
</tr>
<tr>
<td>62</td>
<td>STROBE</td>
<td>Control</td>
<td>Positive external Sample clock source which can be used for dynamic acquisition.</td>
</tr>
<tr>
<td>63</td>
<td>STROBE*</td>
<td>Control</td>
<td>Complementary external Sample clock source which can be used for dynamic acquisition.</td>
</tr>
<tr>
<td>14, 17, 20, 23, 26, 29, 32, 35, 38, 41, 44, 47, 50, 53, 56, 59</td>
<td>DIO &lt;0..15&gt;</td>
<td>Data</td>
<td>Bidirectional digital I/O data channels 0 through 15.</td>
</tr>
<tr>
<td>15, 18, 21, 24, 27, 30, 33, 36, 39, 42, 45, 48, 51, 54, 57, 60</td>
<td>DIO &lt;0..15&gt;*</td>
<td>Data</td>
<td>Complementary bidirectional digital I/O data channels 0 through 15.</td>
</tr>
<tr>
<td>2, 5, 8</td>
<td>PFI &lt;1..3&gt;</td>
<td>Control</td>
<td>Positive input terminals to the NI 656x for external triggers, or output terminals from the NI 656x for events.</td>
</tr>
<tr>
<td>3, 6, 9</td>
<td>PFI &lt;1..3&gt;*</td>
<td>Control</td>
<td>Complementary input terminals to the NI 656x for external triggers, or output terminals for the NI 656x for events.</td>
</tr>
<tr>
<td>1, 4, 7, 10, 13, 16, 19, 22, 25, 28, 31, 34, 37, 40, 43, 46, 49, 52, 55, 58</td>
<td>GND</td>
<td>Ground</td>
<td>Ground reference for signals.</td>
</tr>
<tr>
<td>11, 12, 68, 69</td>
<td>RESERVED</td>
<td>N/A</td>
<td>These terminals are reserved for future use. Do not connect to these pins.</td>
</tr>
</tbody>
</table>
Note If you are designing a custom cabling solution with connector (779157-01) and the NI SHB12X-B12X cable (192344-01), the NI 656x pinout is reversed at the end connector. Refer to Figure 18 for an illustration of the pinout at the end connector.

Figure 18. NI 656x End Connector Pinout
Tables 8 and 9 describe the different conditions indicated by the two NI PXI LEDs.

**Table 8.** ACTIVE LED Indicators

<table>
<thead>
<tr>
<th>Color</th>
<th>Indications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Device not armed and not triggered.</td>
</tr>
<tr>
<td>Amber</td>
<td>Device armed and awaiting Start trigger. If performing a dynamic acquisition operation, the device may be acquiring pretrigger samples.</td>
</tr>
<tr>
<td>Green</td>
<td>Device received Start trigger.</td>
</tr>
<tr>
<td>Red</td>
<td>Error condition.</td>
</tr>
</tbody>
</table>

**Table 9.** ACCESS LED Indicators

<table>
<thead>
<tr>
<th>Color</th>
<th>Indications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Device not ready.</td>
</tr>
<tr>
<td>Amber</td>
<td>Device being accessed by software.</td>
</tr>
<tr>
<td>Green</td>
<td>Device ready to be programmed.</td>
</tr>
<tr>
<td>Red</td>
<td>Running the niHSDIO Self Test VI or calling niHSDIO_self_test produced a failure.</td>
</tr>
</tbody>
</table>
Appendix B: Troubleshooting

Device Front Panel ACCESS LED on PXI Module is Off When PXI Chassis is On

If the ACCESS LED is not lit after you power on the PXI chassis, a problem may exist with the PXI power rails, a hardware device, or the LED.

**Note** The LEDs may not light until the device has been configured in MAX. Before troubleshooting this issue, verify that the device appears in MAX.

Troubleshoot this issue by completing the following steps:

1. Power off your PXI chassis.
2. Disconnect any signals from the PXI module front panel.
3. Remove the PXI module and inspect for signs of damage. Do not reinstall a damaged device.
4. Reinstall the PXI module using the procedure described in step 5. Installing the Hardware.
5. Power on your PXI chassis.
6. Verify the device appears in MAX.
8. If the ACCESS LED still fails to light, contact NI support at ni.com/support.

Device Does Not Appear in MAX

Complete the following steps if the NI device does not appear in MAX:

1. In the MAX Configuration pane, click Devices and Interfaces to expand the category.
2. Click the appropriate Chassis and press <F5> to refresh the list of installed devices.
3. If the device is still not listed, power off the system, ensure the device is correctly installed, and restart.
4. If the device still does not appear under Devices and Interfaces, contact NI support at ni.com/support.

Device Failed the Self-Test

The MAX self-test performs a brief test of device resources. If the device does not pass the self-test, complete the following steps:

1. Reboot your system.
2. Launch MAX and perform the self-test again. If the device still fails the self-test, proceed to step 3.
3. Uninstall and reinstall NI-HSDIO.
4. If the device still fails the self-test, contact NI support at ni.com/support.
I Received a Thermal or Power Shutdown Error

I received the kErrorDeviceShutDownDueToHighTemp or the NIHSDIO_ERROR_DEVICE_POWER_LIMIT_EXCEEDED error, and my device shut down. What should I do next?

To re-enable your device after a hardware shutdown, you must perform a hard reset, in which the device integrated circuits (ICs) are reloaded. To re-enable your device after thermal shutdown, complete the following steps:

1. Power off the computer or chassis that contains the device.
2. Review the procedure in step 5. Installing the Hardware and make any necessary adjustments to ensure that your device is effectively cooled.
3. Call the niHSDIO_Reset Device VI or the niHSDIO_ResetDevice function or perform a device reset in MAX. For more information about performing a device reset in MAX, refer to step 6. Configuring and Testing in MAX. The thermal shutdown error continues to be reported until the device has been successfully reset.

Note The thermal shutdown error is reported until the device has cooled to an acceptable operating temperature and has been successfully reset.

Note Due to power and cooling constraints, not all features of the NI 6555/6556 may be active at the same time. Refer to the NI 6555/6556 Specifications for power limits and to the NI 6555/6556 book in the NI Digital Waveform Generator/Analyzer Help for more information about the power monitoring properties provided by NI-HSDIO.

Performance Issues Using MXI Connection

When using a MXI connection to control the PXI chassis, the MXI Optimization Application must be run prior to using the NI device. By default, this application runs automatically when Windows starts. Use of a MXI connection without running this application may result in a time exceeded or internal software error, or an initialization, timeout, or performance issue when using the NI device.

If you are experiencing errors and are uncertain whether the MXI Optimization Application ran, navigate to Start»All Programs»National Instruments MXI, and select MXI Optimization to launch the application.

If the application is not installed, refer to the software CD included with the MXI kit to install the software. After installation, you may be required to reboot the computer before using the MXI Optimization Application.

If you continue to have initialization or performance issues, refer to the MXI documentation at Start»All Programs»National Instruments MXI, or visit NI Technical Support at ni.com/support.
Where to Go for Support

The National Instruments Web site is your complete resource for technical support. At ni.com/support you have access to everything from troubleshooting and application development self-help resources to email and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European Communities using the manufacturer’s declaration of conformity. This system affords the user protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC for your product by visiting ni.com/certification. If your product supports calibration, you can obtain the calibration certificate for your product at ni.com/calibration.

National Instruments corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas, 78759-3504. National Instruments also has offices located around the world to help address your support needs. For telephone support in the United States, create your service request at ni.com/support and follow the calling instructions or dial 512 795 8248. For telephone support outside the United States, visit the Worldwide Offices section of ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.